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Chapter 

 

1

 

: Basic Concepts

 

his chapter contains a short tutorial designed to familiarize you with the basic 
concepts of making movies with the Adobe Premiere

 



 

 program. For information 
on installing and configuring the program, see the 

 

Getting Started

 

 booklet 

 

accompanying this guide. For information on basic Macintosh

 



 

 features, see your 
Macintosh documentation.

Adobe Premiere is powerful video and audio-editing software designed to be a useful tool 
for the professional and novice alike. Adobe Premiere provides a comfortable and familiar 
working environment for those with both film and video experience. Those with no video 
experience will find the software to be a thorough introduction to the world of desktop 
video. Video and multimedia professionals will find Adobe Premiere a valuable tool for 
tasks such as video editing (both online and off-line) or creating QuickTime

 



 

 movies for 
presentations and CD-ROMs. Many of the program’s features were previously available 
only on high-end professional video-editing systems. 

In many instances, you will encounter terminology and interface designs drawn from 
traditional video production and post-production. For information on the fundamentals 
of video and audio, see Appendix A, “Video Basics.” 

 

Note:

 

 In this manual, commands in submenus are indicated by a preceding slash. For 
example, the instruction: “Choose Import/Project from the File menu,” means that you should 
choose Import from the File menu and Project from the submenu.

 

CREATING DESKTOP VIDEO WITH ADOBE PREMIERE

 

Adobe Premiere lets you combine source material, or 

 

clips

 

, to make a movie, and then view 
and play the movie using any application that supports the QuickTime

 



 

 movie format. 
Your final Adobe Premiere movie is a file you create after assembling and editing clips.

Clips can include the following:

 

O

 

Digitized video captured from cameras, VCRs, or tape decks

 

O

 

QuickTime movies made using Adobe Premiere or other sources

 

O

 

Animations

 

T
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O

 

Scanned images or slides

 

O

 

Digital audio recordings and synthesized music and sound

 

O

 

Adobe Illustrator

 



 

 files

 

O

 

Adobe Photoshop

 



 

 files

 

O

 

FilmStrip format files created in Adobe Premiere and edited in Adobe Photoshop

 

O

 

Titles

 

O

 

Backdrops

You can create your own video and audio clips by recording material to your Macintosh 
hard disk using a variety of hardware products. For more information on recording to 
your hard disk, see Chapter 9, “Capturing Video.” 

 

CREATING AN ADOBE PREMIERE MOVIE: A TUTORIAL

 

Every Adobe Premiere movie starts as a 

 

project

 

—a collection of clips organized along a 
timeline. This section provides step-by-step instructions for building a simple Adobe 
Premiere movie using clips supplied on your program disks. 

Creating an Adobe Premiere movie involves the following basic tasks: 

 

O

 

Starting a new project and importing clips

 

O

 

Assembling clips in the Construction window

 

O

 

Viewing and editing clips in the Clip window

 

O

 

Applying transitions and filters to the assembled clips

 

O

 

Adding a superimposed title to the movie

 

O

 

Previewing the movie

 

O

 

Compiling the assembled clips into a movie and playing it 

 

Note:

 

 The steps for making a movie vary depending on the intended use of the medium. If your 
goal is to make a videotape with full-frame images, you must understand the capabilities and 
limitations of your hardware. For information on hardware requirements, see Chapter 8, 
“Compiling and Videotaping Movies,” and Chapter 9, “Capturing Video.”
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Create a new project and import clips

 

Before you start this tutorial, make sure that you have installed the sample clips included 
with the program in your Adobe Premiere folder on your hard drive.

 

1

 

Double-click the Adobe Premiere program icon to start the program. When you start 
the program, the New Project Presets dialog box appears. 

Every new Adobe Premiere project must be assigned a 

 

preset

 

. A preset specifies the project 
time base, the movie frame rate, and options for compression, previewing, and output. 
Project presets are described in detail in Chapter 2. For now, choose Presentation 
(160 x 120) from the Available Presets list and click OK.

 

2

 

After you choose a preset, six windows appear:

 

O

 

Project window, for importing and storing clips

 

O

 

Construction window, for assembling clips

 

O

 

Info window, for displaying detailed information about clips

 

O

 

Transitions window, for selecting special effects transitions between clips

 

O

 

Preview window, for previewing the movie as you assemble it in the 
Construction window

 

O

 

Commands palette, for quick access to frequently used commands
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When the program opens, the Project window is the active window. You use the Project 
window to stockpile clips for your movie. 

 

3

 

Choose Import/File from the File menu. The Import dialog box appears. In the Adobe 
Premiere folder, locate the sample movie clips supplied with the program. 

 

4

 

Choose 

 

Spotlight

 

, and click Import. The clip name and a thumbnail of the first frame of 
the clip appear in the Project window. For a movie clip, the thumbnail displays an approx-
imation of the first frame in the clip.
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5

 

To import additional clips, choose Import/Multiple from the File menu. The Import 
dialog box appears. In the Adobe Premiere folder, locate the sample movie clips supplied 
with the program.

 

6

 

Choose 

 

Twirl

 

, and click Import. The 

 

Twirl

 

 clip is imported, and the Import dialog box 
remains open.

 

7

 

Use the same procedure to import the video clip

 

 Overhead spin

 

, the title clip 

 

Circus.title

 

, 
and the audio clip 

 

Circus audio. 

 

When you have imported these clips, click Done.

 

Assemble clips in the Construction window

 

You use the Construction window to assemble clips into a movie. The Construction 
window contains multiple tracks for placing video and audio clips. The video tracks 
include the main video tracks A and B, the T track for transitions, and the S track(s) for 
superimposed video clips. The lower set of tracks is for audio clips. Tracks are identified 
in the vertical bar at the right of the window.

At the top of the Construction window is a 

 

time ruler

 

 that indicates elapsed time in the 
movie. The tick marks on the ruler can represent anything from a single frame to a 
2-minute interval, depending on the time unit selected. You can use the slider at the 
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bottom of the Construction window to change the time unit, thereby changing the level 
of detail displayed in the window; a smaller time unit causes more 

 

thumbnails

 

 (frames in 
the clip) to be displayed. 

 

1

 

Position the pointer over the thumbnail of the 

 

Spotlight

 

 clip in the Project window; the 
pointer changes to a hand. Hold down the mouse button, and drag the clip onto the top 
track (track A) of the Construction window. The track turns dark gray to show where the 
clip will be placed. 

 

Video track B

Play button

Time ruler

Video track A

Transition track

Superimpose

track

Audio track A

Audio track B

Current time unit

Time unit selector

Tools palette

Work area bar
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2

 

Drag to align the left edge of the clip with the left edge of the Construction window. 
Release the mouse button to place the clip.

When you place a clip in the Construction window, it is displayed as a series of thumbnails 
that represent frames of the clip. The width of the strip of thumbnails represents the dura-
tion of the clip. You can move clips in the Construction window simply by dragging them. 

 

3

 

Drag the 

 

Twirl

 

 clip from the Project window onto track A so that the left edge of the clip 
butts up against the right edge of the 

 

Spotlight

 

 clip. 

Positioning the two clips like this creates a 

 

cut

 

, or transition, from the 

 

Spotlight

 

 clip to the 

 

Twirl

 

 clip.

 

Preview the movie

 

You can preview the movie at any time to view the results of your work in the Construction 
window. 
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1

 

Place the pointer in the time ruler at the top of the Construction window; the pointer 
changes to a downward-pointing arrow. 

 

2

 

Hold down the mouse button. The Preview displays the movie frame that corresponds 
to the current location in the time ruler. 

 

Note:

 

 If the pointer is not positioned correctly, the Controller window may appear when 
you hold down the mouse button. If this happens, simply close the Controller window and 
try again.

 

3

 

To see a preview of the movie play in the Preview window, drag to the right while 
holding down the mouse button. Note that when the first clip ends, the second clip begins 
playing.

 

Change the duration of a clip

 

After previewing, you may decide that you don’t need to include an entire clip in your 
movie. You can use the Clip window to view a clip and choose which frames you want to 
include in the Construction window. The frames that are included are defined by the clip’s 

 

in point

 

 and 

 

out point

 

. The process of changing these points is called 

 

trimming

 

 the clip. 
Changes made to a clip in the Clip window are automatically applied to the clip in the 
Construction window.

Cursor position

in the time ruler
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1

 

Double-click a thumbnail of the 

 

Twirl

 

 clip in the Construction window. 

The Clip window opens with the starting frame of the 

 

Twirl

 

 clip. Notice that an in point 
indicator appears in the upper left corner of the window.

Controls for viewing and playing the clip are located in the lower portion of the window. 
The frame indicator in the center displays the address of the current frame in the Society 
of Motion Picture and Television Engineers (SMPTE) timecode format (Hours:Minutes:-
Seconds:Frames). Below the frame indicator, the duration of the clip is displayed using the 
same format. (For more information on timecode, see “SMPTE Timecode” on page 298.)

 

2

 

Click the play button to play the clip in the Clip window. You can also drag the slider 
control or the jog control to view the clip as it plays in the forward or reverse direction.

 

3

 

Drag the slider bar (located to the left of the play button) back to rewind the clip until 
00:00:02:17 appears in the frame indicator. The displayed frame will be the new out point 
for the clip. For more precision in locating the frame, drag the jog control above the slider 
bar, or use the Frame Forward and Frame Backward buttons.

Play button

Stop button

Jog control

Frame forward

and backward

In point 

indicator

Play In/Out button

Loop button

Clip duration

Slider bar Clip duration
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4

 

Set the new out point by clicking the Out button in the lower right corner of the window.

An out point marker appears in the upper right corner of the window. The clip is short-
ened in the Construction window accordingly. 

To keep the screen from becoming too cluttered, close the Clip window when you have 
finished adjusting the clip duration. 

 

Note:

 

 You can also drag the edges of a clip in the Construction window to change its in and 
out points. For more information on setting in and out points, see “Trimming Clips” 
on page 79.

 

Trim clips at the cut point

 

The most accurate way to change the in points and out points of clips while getting instant 
feedback on the effect in the Construction window is to use the Trimming window. The 
Trimming window lets you simultaneously change the in points and out points of the clips 
on both sides of a cut. 

Out button
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1

 

Click the right arrow under the Construction window’s play button to move the edit line 
to the cut between the 

 

Spotlight

 

 clip and the 

 

Twirl

 

 clip.

 

2

 

Choose Trimming from the Window menu. 

The Trimming window appears, displaying the frames on the left and right sides of the cut: 
the out point of the 

 

Spotlight

 

 clip and the in point of the 

 

Twirl

 

 clip, respectively.

In this case, the out point of the 

 

Spotlight

 

 clip is also the last frame of the source clip, as 
indicated by the red page peel icon in the corner of the clip. Likewise, the in point of the 

 

Twirl

 

 clip is also the first frame of that source clip.

 

3

 

Click –1 under the left clip (

 

Spotlight

 

) three times to subtract three frames from the out 
point of that clip. 

Edit line

Edit line right button

Page peel icons

Collapse preview button

Edit line left 

and right buttons

Play button Add and subtract

frames
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Notice that the edit line moves to the left in the Construction window as the out point 
changes, and the clip to the right of the edit point (

 

Twirl

 

) shifts left. The total number of 
frames subtracted from the out point appear at the bottom of the Trimming window.

When you trim clips in the Trimming window, clips and transitions on other tracks shift 
right or left in order to maintain their positions relative to the clip being trimmed. You can 
lock individual tracks to keep their contents from shifting during editing. For information 
on track locking, see “Locking Tracks in the Construction Window” on page 97.

 

4

 

Click –5 under the right clip (

 

Twirl

 

) to subtract five frames from the in point of that clip. 
Notice that the 

 

Twirl

 

 clip shortens in the Construction window. Now click +1 to add back 
one frame to the in point.

 

5

 

Click the Play button to preview the edits in the Trimming window. The window plays 
the five seconds of the clip that surround the edit point. (You can set a different number 
of seconds to include in the Preview as one of the Trimming window options.)

 

6

 

Close the Trimming window.

 

Add a transition 

 

You can create gradual transitions between clips. However, clips must be located on 
separate video tracks A and B to apply a transition between them. 

 

1

 

Make the Construction window active by clicking in the window or by choosing 
Construction from the Windows menu.

Total number of frames subtracted
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2

 

Drag the 

 

Twirl

 

 clip from track A to track B and position it so that the clip overlaps 
approximately one inch (slightly less than one second on the time ruler) with the 

 

Spotlight

 

 
clip on track A. The amount of overlap determines the length of the transition.

 

3

 

In the Transitions window, scroll to the Cross Dissolve transition. (You can also type the 
first letter of a transition to scroll to that transition.)

 

4

 

Click and drag the transition onto the T track between the two movie clips. As you drag 
the transition onto the space where the two movie clips overlap, the program automati-
cally adjusts the length of the transition to fit the overlapping section.

 

5

 

Preview your movie again by holding down the mouse button and dragging the arrow 
through the time ruler. Notice how the 

 

Spotlight

 

 clip gradually fades out while the 

 

Twirl

 

 
clip fades in.
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Add a third clip and another transition

 

1

 

Drag the 

 

Overhead

 

 

 

spin

 

 clip from the Project window onto track A and position it so it 
overlaps the clip on track B by approximately one second on the time ruler.

 

2

 

In the Transitions window, scroll to the Iris Round transition. 

 

3

 

Drag the transition onto the T track between the 

 

Twirl

 

 clip on track B and the 

 

Overhead 
spin

 

 clip on track A.

In most situations, Adobe Premiere automatically sets the correct direction of a transition 
when it is placed between clips in the Construction window. In this case, a circular wipe 
should reveal the image on track A as it replaces the image on track B.
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4

 

To check the direction of the Iris Round transition, double-click the transition in the 
Construction window. The Iris Round Settings dialog box appears. 

The animated display in the lower right corner of the dialog box should indicate that 
image A is wiping over image B. If this is not the case, click the blue arrow to the left of the 
display so that the arrow is pointing upward.

 

5

 

Click OK.

 

Change the time unit in the Construction window

 

At this point, your movie is approximately 8 seconds long. Depending on the size of the 
Construction window on your monitor, the entire movie may not be visible. To see more 
frames of your movie in the Construction window, change the time unit. The time unit is 
currently set to 1 second, which means that the Construction window displays 1 thumb-
nail for each second of a clip.

Animated display
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Drag the slider at the bottom of the Construction window to the right one notch. The time 
unit changes to 2 seconds, which means that the Construction window now shows 2 
thumbnails for every 2 seconds of a clip. Consequently, you can see more of the movie in 
the Construction window.

To quickly see the entire movie in the Construction window, no matter how long the 
movie is, you can press the backslash key (\) while the Construction window is active. The 
time unit selector adjusts accordingly.

 

Apply a filter to a clip

 

You can apply filters to clips to change their appearance or sound. Adobe Premiere 
includes more than 40 movie and still-image filters and five audio filters. 

 

1

 

Click the 

 

Twirl

 

 clip on track B to select it; a dashed line appears around the border of 
the clip.

 

2

 

Choose Filters from the Clip menu. The Filters dialog box appears.

Time unit selector



 

Premiere User Guide 6/1/94 10:36 c1.pdf.frame

 

Right master page

 

3

 

Scroll through the Available list and select the Hue & Saturation filter. 

 

4

 

Click Add. The Hue & Saturation Settings dialog box appears.

 

5

 

Drag the Hue slider to change the color of the clip. 

 

6

 

Drag the Lightness slider to lighten the clip. 

 

7

 

Click OK when you have finished.

 

Apply another filter to the same clip

 

You can add multiple filters to a clip. Adobe Premiere applies the filters in the order that 
you list them in the Current list in the Filters dialog box.
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1

 

Select the Crop filter from the Available list; then click Add. The Crop Settings dialog 
box appears. 

The dialog box contains a preview image from the clip and slider controls for trimming 
unwanted pixels from the edges of the clip. It also contains a zoom tool and a hand tool 
for observing the effects of a filter more clearly. Note that the preview of the clip shows the 
effects of the Hue & Saturation filter.

 

2

 

Click the zoom tool and position it in the lower left corner of the preview image.

 

3

 

Click twice to magnify the preview image by two levels. 

Note the dark border along the bottom and left edges of the clip. You can eliminate these 
borders by cropping the edges.

 

4

 

Drag the Bottom slider to the right until it reads 1 (pixel). Do the same with the Left 
slider. This crops the image by 1 pixel on the bottom and left sides. (Adobe Premiere auto-
matically resizes the clip to its original size after it is cropped.)

 

5

 

Double-click the hand tool to return the display to the entire preview image.

Zoom tool
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6

 

Click OK to close the Crop Settings dialog box; then click OK to close the Filters dialog 
box.

The program adds a blue line at the top of the clip in the Construction window to indicate 
that one or more filters have been applied.

 

Use the Preview command to preview the transitions and filter effects

 

The Preview command provides a more accurate way to preview than dragging through 
the time ruler. You specify which part of the Construction window is previewed by posi-
tioning the yellow bar at the top of the window. All clips, transitions, and filter effects 
located beneath the yellow work area bar are previewed when you choose the Preview 
command.

 

1

 

Before previewing the movie, save the project by choosing Save from the File menu and 
typing a name for the project. (You cannot preview an unsaved project.)

 

2

 

Position the pointer over the red triangle at the right edge of the yellow bar. If the bar is 
not visible, double-click the gray bar above the time ruler at the top of the Construction 
window.

 

3

 

Click and drag to the right until the right edge of the yellow bar aligns with the right 
edge of the 

 

Overhead

 

 

 

spin 

 

clip on track A.

Work area bar
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4

 

Choose Preview from the Project menu, or press Return. 

Adobe Premiere displays the Building Preview dialog box and gives a time estimate for 
compiling the preview. After a few moments, the preview plays in the Preview window, 
showing the 

 

Spotlight

 

 clip, the 

 

Twirl

 

 clip with the filters applied, and the two transitions. 
Press Return to see the preview again. This time, you don’t have to wait for the preview to 
build.

 

Add a superimposed title to the S1 track

 

Adobe Premiere treats titles as clips. They are usually added to a superimpose (S) track so 
that they can be superimposed, or 

 

keyed

 

, over a movie clip. The duration of a title clip can 
be changed by choosing Duration from the Clip window or by dragging the edges of the 
clip in the Construction window.

 

1

 

Drag the 

 

Circus.title

 

 clip from the Project window onto track S1 so that the left edge of 
the clip aligns with the beginning of the track.

 

2

 

Position the pointer over the right edge of the 

 

Circus.title 

 

clip. The pointer changes into 
a stretch pointer.

Stretch pointer
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3

 

Drag the edge of the clip until it aligns with the left edge of the 

 

Twirl

 

 clip on track B. This 
extends the duration of the title clip to approximately 2 seconds.

 

4

 

With the 

 

Circus.title

 

 clip selected in the Construction window, choose Transparency 
from the Clip menu. The Transparency Settings dialog box appears.

 

5

 

To key the title against the background image of the 

 

Spotlight

 

 clip, choose White Alpha 
Matte from the Key Type pop-up menu. Adobe Premiere uses the title’s existing alpha 
channel to create a mask for superimposition. For more information on working with 
superimpositions, see “Superimposing Clips” on page 179.
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6

 

To see a preview of the title over the actual background image, click the page peel icon 
under the Sample box.

The title is shown superimposed over the first frame of the 

 

Spotlight

 

 clip. 

 

7

 

Click OK.

 

Note:

 

 The 

 

Circus.title

 

 clip was created with the Adobe Premiere Titler. For information on 
using the Titler, see “Creating Titles” on page 193.

 

Add sound to the movie

 

You add sound to a movie by dragging audio clips onto the audio tracks in the Construc-
tion window.

 

1

 

Drag the thumbnail of the 

 

Circus audio

 

 clip from the Project window onto audio track 
A in the lower half of the Construction window. 

 

2

 

Align the left edge of the audio clip with the left edge of the Construction window.

 

3

 

To preview your movie with sound, adjust the yellow work area bar to select the part of 
the movie you want to preview and press Return.

Page peel icon
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Compile and play the final movie

 

When you have finished assembling clips in the Construction window and are satisfied 
with the previewed results, you are ready for the program to create, or 

 

compile

 

, the final 
QuickTime movie file.

 

1

 

Before creating the movie, save the changes you have made to the project by choosing 
Save from the File menu. It’s always a good idea to save your project often as you work.

 

2

 

Choose Movie from the Make menu. The Make Movie dialog box appears.

 

3

 

Click Output Options. The Project Output Options dialog box appears.

This dialog box lets you change characteristics of the final movie, including size, frame 
rate, compression type, and format. See Chapter 8, “Compiling and Videotaping Movies,” 
for a complete description of output options.

 

4

 

Make sure that the Open Finished Movie option at the bottom of the dialog box is 
selected. This option tells the program to automatically open the movie when it has 
finished compiling and saving the movie.
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Leave the other options at their current settings (these were set when you chose a project 
preset), and click OK.

 

5

 

Name the movie in the Make Movie dialog box, and click OK. A progress bar appears 
while Adobe Premiere compiles the movie. 

When the movie has been compiled and saved, Adobe Premiere opens the movie in a 
Clip window. 

 

6

 

To play the movie, press the Play button in the Clip window.

 

Play the movie using Print to Video

 

You can use the Print to Video command to play a movie in the center of your screen, with 
the rest of the screen blacked out. Print to Video is also used to output a finished movie to 
videotape. For information on making videotapes with Adobe Premiere, see Chapter 8, 
“Compiling and Videotaping Movies.”

 

1

 

Click the Clip window to make sure that it is the active window.

 

2

 

Choose Export/Print to Video from the File menu. The Print to Video dialog box 
appears.

 

3

 

Leave the options as they are, and click OK.

 

4

 

The screen goes blank for 1 second, and then the movie plays in the center of the screen.

The Adobe Premiere program disks include a sample project and its clips, which you can 
open and make into a movie. You should look through this guide to familiarize yourself 
with Adobe Premiere’s features; then examine the sample project and make a movie to 
learn more about how Adobe Premiere handles clips, transitions, and superimposed 
images. 

Play button
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